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1.0 Workshop Overview

In this section, we will look atf the key concepts covered in this hands-on workshop. From
the student and instructor perspectives, you will be infroduced to the teaching and
learning features of Blackboard Learn™.

First, you will log in as a student and become familiar with how the course environment
appears to your students. You will learn how to access and navigate through tools and
content.

Next, from the instructor perspective, you will follow a scenario-based approach
representing the tasks you will complete to set up your course. You will begin with
examining different strategies for organizing the Course Menu, which is the students’
access point to tools and content. Next, you will learn how to customize your course
style and course Home Page. Finally, you will become familiar with somme common start-
up tasks, such as creating announcements, adding calendar entries, setting up
discussion forums, and adding textbook information.

Throughout the workshop, pedagogical issues related to teaching and learning online
will be introduced.



Roadmap

2.0 Student Experience

Explore the course environment

Log in to Blackboard Learn™ and
explore the My Institution tab.

Access course componenis
Navigate through the course
Home Page, course content, and
tools using the Course Menu and
breadcrumbs.

Think of your students first
Explore ways to ensure a positive
start for your students.

3.0 Creating your Course Menu
Plan the links

Consider your course content and
how to represent it through links on
the Course Menu.

Add the tools
Add regularly used tools to the
Course Menu.

Create the Content Areas
Decide how you will organize
information, and then add the
Content Areas and materials.

Organize the links

Choose the best order for Course
Menu links and add subheaders
and dividers.

®

4.0 Customizing Your Course

Customize course style

Experiment with the appearance of the Course
Menu, change the default content view, add
a banner to the course entry page, and
change the course entry point.

Select tools
Change tool availability.

Customize the Home Page
Add, remove, and reorder modules. Edit
notification settings.

5.0 Day 1 Tasks

Start from the beginning

Create a welcome announcement and add
calendar entries.

Make additions

Add syllabus lessons, create a discussion forum,
and add textbook information to your Getting
Started Content Area.

Welcome your students

Understand the importance of first impressions
and how to make your students feel
comfortable in an online course.



2.0 Student Experience

In this section, you will explore Blackboard Learn as a student. You will see how course
content appears to students and try common tools from a student perspective. The
information will provide context for the decisions you will make as an instructor.

Learning Outcomes

After completing this section, you will be able to:

Log in to Blackboard Learn

Explain the information available on the My Institution tab

Access the What's New and To Do items from a course's Home Page
Access content and tools from the Course Menu and Tools link
Describe what a Content Area is and navigate content

Use breadcrumbs to navigate the course

Change the Course Menu from List View to Folder View



Logging In

The first step in using Blackboard Learn is to log in. Your institution will provide the URL,
username, and password.

Have an account?

Please enter your credentials and click the Login button
below.

# Create a New Account
Username: [tstenson| |

Password: senes » View Course Catalog

Forget Your Password?

- #» Preview as Guest

Figure 1.1

» QUICK STEPS: logging in

1. Inyour browser, type or paste the URL.
2. Type your Username and Password.
3. Click Login.

After logging in, the tabs you see in the page header will depend on what capabilities
your school has licensed. For example, if your school has licensed the content
management capability, you will see a Content Collection tab.

ﬂH Places ﬁ.. Haomme H Help i'_u Lagiaut

UNIVERSITY

1 My Institution Courses Community Content Caollection

Figure 1.2

© 2009 Blackboard Inc. -9- Getting Started



Exploring the My Institution Tab

First, we will explore the contents of the My Institution tab. It contains the My Courses
module which lists all the courses to which you have access.

i:, Hotne E Help i‘g Logot

r Institution

UNIVERSITY

My Institution Muatifications Dashboard
Add Module Personalize Page || Tl

» i Announcements Mo Institution Announcements have been Courses in which you are enrolled:
:.?alindar postedinthe last T days. () Earth Systern Seience
asks
& ’ Earth System Science Announcements:
> B Yiew Grades > Mentors Available
» 4 Send Email » Mentors Available
f rts...
» g Mser Directory [Tors smnouneements () Introduction to Oceanagraphy (Materials Demo)
» & Address Book
» Bl Personal My Calendar =
i =
Information 11:00 AM - 12:00 PM on 9/17/09; My Tasks
Journal Entry Due My Tashks:
What's New = = E3 _ﬁ:: onDL::'LI-laallilsn;{ng;i:;mnS for more specifics. Introduction to Oceanography (Materials
n Actions = Demo):
e mare calendar events . » Group Projects Bedin
Figure 2
» Take Note

A. From the page header, go to My Places, your institution’s home page, Help, or
log out of the system.

e Clicking the My Places link allows you to edit your personal information
that is seen by other course members and to set privacy opftions.

e From My Places, you can also add an avatar image to use in the course.
In the Merriam-Webster OnLine dictionary, an avatar is defined as “an
electronic image that represents and is manipulated by a computer
user.” An avatar image can be a photo of yourself or can be one you
create for your alter ego.

e Your avatar will appear throughout the course, such as in the page
header, in the What's New module, and with Journal entries. The
recommended pixel size for an avatar image is 150 by 150. Adding an
avataris a function that must be enabled by the system administrator.

B. To select a course, click its title in the My Courses module.

© 2009 Blackboard Inc. -10- Getting Started



Student Experience: Exploring the My Institution Tab

The main My Institution tab contains modules. Modules are windows of content that
organize content and links, and help students navigate to areas in their courses. The
system administrator can rename modules and determines which will appear when you
log in to your course for the first time.

Modules on the My Institution tab collect information from all the courses you are
enrolled in, giving you a total picture of news and activity for your courses. The following
modules can be found on the My Institution tab:

e Tools — view announcements and grades for all courses in which you are
enrolled. Send email to memibers of any of your courses. View course calendar
dates and tasks added by instructors and add your personal calendar events
and tasks, which will remain private. Use the Personal Information link to access
and edit the same personal information found in the My Places link in the
header.

¢ My Announcements — displays announcements for courses in which you are
enrolled. It can also contain announcements from your institution’s system
administrator. Announcements communicate important, time-sensitive
information.

¢ My Calendar - displays calendar dates for courses in which you are enrolled and
any personal events you have added. You can add personal events when
accessing the Calendar from the My Institution tab and clicking the Create
Personal Event link on the Action Bar. You cannot create personal events from
the Calendar in the course environment.

e Opfional modules — Add a module to view the list of available modules, such as
Dictionary, Report Card, and Notes. Descriptions are provided in the list to help
you choose the most significant.

Users are able to add and delete some modules, collapse individual windows, and
change the position of modules. To move a module, point to the title bar to access the
four arrows. Press and drag the module into its new location and release.

© 2009 Blackboard Inc. -11- Getting Started



Hands-on Activity @

Log in to Blackboard Learn.
Page header

e Go to My Places and edit your personal information. Add an avatar, if allowed.

e Depending on what capabilities your school has licensed, you may see more
than one row of tabs. In the first or top row of tabs, click Courses to view the
information.

My Institution tab

e In the first or top row of tabs, click My Institution. On the My Institution tab, click
Add Module on the Action Bar to view descriptions of the available modules.
Choose two modules to add.

e Click Personalize Page on the Action Bar and change the color palette.

e Use the drag-and-drop function to move modules into the order you prefer.

© 2009 Blackboard Inc. -12- Getting Started



The Course Environment

You access a course by clicking its title on the My Institution tab. Courses will vary in
design depending on the instructor and the institution, but there are some common
features.

i-;.. Home: ﬂ Help i'p Logowt

ur Institution

UNIVERSITY

iy Institution Courses

Earth System Science Home Page

S=R=N" .
Home Page ()

Home Page

Getting Started
My Announcements

Weelk 1 Earth System Science
Discussions o ¥ mMentors Availahle

Aszighments
Mare announcements. ..

Tools 12:00 PM - 10:00 PM on 9/17/09:
Weh Sites Worksheet 1 due

Figure 3

» Take Note

A. Page header —-identical to the page header you saw upon logging in, including
the My Institution and Courses tabs. The system administrator can rename tabs.

B. Course Menu - the access point for all course content. Instructors decide which
links are available here.

C. Content frame - displays the selected tool or Content Area. By default, when
you enter a course, the Home Page appears. The first page you see is chosen by
the instructor and is called the course entry point.

© 2009 Blackboard Inc. -13- Getting Started



Exploring the Home Page

The Home Page contains modules that provide students with an intuitive way to
navigate through a Blackboard Learn course, and keep abreast of content additions
and due dates through notifications. The modules are similar to those found on the My
Institution tab, but the information appearing pertains only to the course currently being
viewed. The default modules are selected by the administrator, but the instructor can
remove, add, and reorder modules. Two of the most relevant modules for students are
What's New and To Do. Any new content added by the instructor appears when the
Home Page is accessed.

9:00 AM - 10:00 AM on 9/25/09:

i Guest Lecture
* Mentors Available Plan to sttend the guest lecture by Gisells Holum,
author of our supplementary text.

more calendar events. ..

Earth System Science

more announcements...

Earth System Science:
Sion up for group project o5 | Edit Notification Settings |
more tasks
What's Past Due Actions =
% All Items (0) ¥
ooy EditNotification Setiings | Actions ¥ | || | What's Due Actions
e ——— . Select Date: [09/22/2008 Go |
# Assignments {2} ¥ # Today (1) %
\dentification Exercise (% Identification Exercize ¥ - Due 002200
Dpinion Paragraph % ¥ Tomorrow (0} ¥
# Content (3) ¥ ¥ This Week (1) ¥
eek 1 Overview ¥ ¥ Future (0} ¥
Earth Science Mews ¥ Last Updater: September 22, 2009 09:54 A

Fig;Jré 4?
» Take Note

A. What's New — contains links to any new content, such as announcements,
assignments, tests, surveys, newly graded items, Mashups, and unread Discussion
Board messages.

B. To Do - divided into What's Past Due and What’s Due. This information can be
used as the launching point for a student’s daily course work.

© 2009 Blackboard Inc. -14- Getting Started



Student Experience: Exploring the Home Page

Module Options

Ly | Edit Motification Settings | Actions _
¥ Assignments (5) > Expand All
) . . » Collapse All
¥ Courses/Organizations (1)
» Dismiss All
¥ Discussion Board (1)
» Refresh
¥ Gradebook (1)
¥ sSurveys (1) ¥

Figure 4.2

» Take Note

A. Move your mouse pointer over the double arrows to expand any drop-down list.

B. Use the Actions drop-down list to expand, collapse, or dismiss all items in the
module. When items are dismissed, they are deleted from the notification
module.

o=

Actions

o
W

What's New

&:1 . . . .
Ky Edit Motification Settings |
# Assignments (5)

Fesearch Fesponse ¥ @

Initial Group Plan ¥ | © Dismiss
Figure 4.3

ldentification Exercisg

Opinion Paragraph 3 * Open

» Take Note

A. Each item in the What's New and To Do modules has an Action Link. Click the
Action Link fo access the item’'s contextual menu.

B. You can open or dismiss the item. When an item is opened, you are taken
directly to the content. If you choose to view a recently graded item, you are
taken to the My Grades tool.

© 2009 Blackboard Inc. -15- Getting Started



Student Experience: Exploring the Home Page

arth System Science

¥ Mentars Available

mare announcements...

300 PM - 4:00 PM on 10/19/0%9%;
Guest Lecture

mare calendar events..

My Tasks: oo, Edit Naification Seftings |
Earth System Science: What's Past Due Actions =
» Bigh up for grodp project ¥ All tems {0} ¥
more tasks... What's Due Actions
Figure 4.4
» Take Note

A. Click Manage to edit the view of what appears in the module. For example, edit
the Announcements module view to include announcements for 7 days, 30

days, or all announcements.

B. Click the “more” link in a tool module to be taken to a tool's main page. For
example, click the “more tasks” link to be taken to the main Tasks page to set

the status of the task.

C. Click Open in a New Window to view the module in a separate window. The
window can be moved to a different screen location. For example, keep the To

Do module window open as you navigate through the course.

© 2009 Blackboard Inc.
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The Course Menu

Eli=R=N- .
TG

Home Page
Getting Started My Announcements
..... WEEH1 Earth 5_'0,!'315‘3‘“1 Seience

. ) ¥ hentors Available
Discussions
Course Ellnge < My Tasks

Earth Science YWeh Sites

My Tasks:

Earth System Science:
Groups > Gign up far group project
Tools

Identification Exercise 0

[l . . . .
= Edit Motification Settings
by Calendar G by |
¥ Assignments (2)
Figure 5.1
» Take Note

Access all course content from the Course Menu. It can contain links to the following:

A. Content Areas - top level containers that organize and store course content,
such as lecture notes, assignments, and tests. In the preceding image, the Week
1 Content Area contains items that will be used in a one week period.

B. Individual tools - links to tools students will need often, such as the Discussion
Board and Blogs.

C. Externallinks — Web sites used for an assignment.

D. Course links — direct links to content also available in a Content Area that you do
not want students to miss.

E. Module pages — customized pages that contain modules, such as What's New, a
dictionary, a thesaurus, and My Calendar.

© 2009 Blackboard Inc. -17 - Getting Started



Student Experience: The Course Menu

Course Menu Views

me Page
2 Earth System Science » # Earth System Science »
{ume Page @ Home Page
Started =5 Getting Started
golaned Gy || [ Opinion Par.. My Announcements
e % Interest In... Earth Syste
eektt ] e Getting to ...
. . . ¥ Mentor
Discussions )
=5 Week 1
CourseBlog | 14 b [ Study Guide
Earth Science Weh Sites | | ¢ . El |dentificat... E sks:
E'ﬁ Discussions Earth System Science:
Groups | [ i Ge’mr‘m o » Sign up far group project
Tools |l 4 Identificat...
""" Sreern WhatsNew
-5 Course Blog
o BB, 2" Edit Notification Setting
Figure 5.2
> Take Note

Change what appears in the Course Menu and where the menu itself appears.

A. List View - displays the top level of the Course Menu only.

B. Folder View — displays the entire hierarchy of material. Exoand and collapse
folders, and access links within folders.

Display Course Menu in a Window — displays the Course Menu in a separate
window. The window can be moved to a different screen location.

D. Hide or Show Course Menu - collapse the Course Menu to focus attention on the
content frame.

E. Collapse or Expand the Course Menu in the sidebar — collapse the entire Course
Menu so that the content frame fills the window.

F. Go to Course Eniry Page —in the content frame, display the page chosen by the
instructor as the starting point.

© 2009 Blackboard Inc. -18- Getting Started



Accessing Content in Content Areas

A Content Area can contain multiple components. For example, the instructor may
create a Content Area containing a week’s worth of course material, such as readings,
an assignment, a discussion forum, and a URL.

Ccorn system science JRCRR

8| 0O £ L.
— % Week 1
# Earth System Science *

Home Page ~ Week 1 Overview
Getting Started Atthe end ofthis unit, you will be able to:
Week1 a e Describe the rock cycle model
Discussion

4 » Describe the sources of energy driving
Course Blog

Earth Science Web Sites Differentiate hetween extrusive and int

Listthe four classes of igneous rock |
Groups

ldentify the most commaon rack found g

~  Week 1 Readings o
Attached Files | Lecture and Readings (26.5 KB

Fleasze allow two to three hours to complete

Identification Exercise
Attached Files ] WWeek 1 \Worksheet (26 5 KE)

Tools

Week 1 Opinion

Each weekyou will weigh in on a topic that pe
opinion. Feel free to respond to your classma

Earth Science News
Q Spend same time explaring this web site.

Figure 6.1

» Take Note

To navigate Content Areas:

A. On the Course Menu, click the name of the Content Area. The content appears
in the content frame.

B. In the content frame, click a link to access its content, such as a Discussion Board
link or a file link.



Student Experience: Accessing Content in Content Areas

The following table identifies some of the components commonly added to Content
Areas. In this workshop, the word item is also used as a generic term meaning any one
of the components added to a Content Area.

Symbol Description

Folder — further organizes content

Learning Module - further organizes content

ltem — text or file

Assignment —link fo an assignment

Course Link — link fo a tfool or other area in course

URL - link to a Web site

Test —link to a test

Survey - link to an ungraded survey

Discussions — link fo a Discussions forum, added as an Interactive Tool

Blog - link to an individual blog entry, added as an Interactive Tool

Journal - link an individual journal entry, added as an Interactive Tool

SIElETEEE AT T

Chat - link to an individual chat session, added as an Interactive Tool

NOTE: The system administrator selects the icon set for the institution so you may see
different icons than shown in the preceding table.



Student Experience: Accessing Content in Content Areas

Breadcrumbs

As you view the items and links presented in a Content Area, use the breadcrumbs to
navigate to previous pages. In the following example, click the fitle of the course in the
breadcrumibs to return to the course entry point, which is set by the instructor. In this
course, it is the Home Page.

hily Institution Courses

G b T S Week 1 F Idertification Exercize » Upload Assignment: ldentification Exercise 6
E| O 2]
Upload Assignment: Identification Ex

Home Page
Getting Started

(M Assignment Information
Weealk 1

Mame: |[dentification Exercise

Discussions

Figure 6.2

© 2009 Blackboard Inc. -21 - Getting Started



Using the Tools Link

On the Course Menu, the Tools link contains links to all of the tools the instructor has
made available in the course. The instructor can rename the link or remove it.

Introduction to Oceanography--Section 2 B -+]H

B0 O

“

14 Tools
# Introduction to
Oceanography--
Section 2
Home Page
Content @ Announcements
Discussions Create and view Course Announcements
Groups E
Assignments L
Tools
My Gra Create and manage blogs for Courses
and Course Groups.

Figure 7

» QUICK STEPS: accessing tools using the Tools link

1. On the Course Menu, click Tools.

2. On the Tools page, select the name of the tool to access.

Add Course Menu links to tools that will be used often. In the preceding example, a link
to the Discussion Board is added to the Course Menu so students can access it directly.

© 2009 Blackboard Inc. -22 -
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Hands-on Activity E

For this activity, use your Student Course.

Home Page

e Use the Actions drop-down list to expand all of the items in the What's New
module. Use the Collapse function at the top of the module to hide its contents.

e Open several of the links. Use the Course Menu to return to the Home Page.
Course Menu

e Select a Content Areq, such as Getting Started or Units, and explore its contents.
Use the breadcrumbs to return to the Home Page.

Tools Link

e Select the Tools link in the Course Menu and access several tools.

List View and Folder View of Course Menu

e Click Folder View and select Expand All. Use the links to navigate through the
course. How does Folder View compare to List View?e

e Return to List View.

© 2009 Blackboard Inc. -23 - Getting Started



Best Practice: Remember the Student

As you set up your online course, think about how your students will experience your
course. If possible, ask someone who is not familiar with the material to critique it
through the eyes of a student.

A Clear Beginning

In a face-to-face classroom, after welcoming the students to class, you likely spend the
first class session distributing the syllabus, elaborating on its contents, reviewing
expectations, and answering questions.

In an online course, this familiar pattern is missing, and students may feel anxious about
what to do next. In fact, the start of an online course can create more student anxiety
than a traditional face-to-face course. Here are some tips on how to put your students
at ease:

e Be absolutely clear about where and how to begin the course. Put first steps or
orientation materials in prominent locations.

e Be prepared to spend the first few days establishing rapport with your students.
Be available to answer questions, clarify expectations, and generate excitement
about the course.

e Explain tasks clearly. Carefully select clear wording that will not be
misinterpreted. Ambiguity in objectives, descriptions, or directions can be
magnified in an online course, causing additional work and stress for you and
your students.

The Visual Appeal of Your Course

Another way to ensure a positive start for both you and your students is to understand
the principles of good Web design and to examine your course with a critical eye. A
simple yet professional course design is the gold standard. Simple does not mean
uninteresting. Clean design styles are inviting, easy to view, and most importantly, easy
to navigate.

e Use consistent page design or consider developing page templates to keep your
use of headings, fonts, and colors the same throughout the course.



Student Experience: Best Practice: Remember the Student

e Make sure images have small file sizes and download quickly. If you have a large
image, provide a thumbnail that links to the full-sized image. Avoid using too
many images on one page.

e Add visual interest with meaningful icons and attractive banners.

e Keep it clean and simple. Very dramatic or highly animated designs are
distracting. Make unneeded elements unavailable and introduce them as
necessary.

Design Easy to Read Pages

Students will become frustrated and skip content if pages are difficult to read and scan.
Design pages that are concise, organized, and visually appealing.

Studies' show nearly 80% of users scan a Web page for information, rather than read it
word for word. Instead of copying printed course material into your online course,
reformat the material so it is easier to read online.

Here are some tips to make your pages user-friendly:

e Use a straightforward, casual writing style. Elaborate language is not only disliked
by Web users, but reduces comprehension.

e Present text in small chunks by including one idea per paragraph. Use plenty of
headings and white space. Use bullets to present lists and summarize important
points. This allows users to easily scan the page for important information.

e Use appropriate font size—between 12 and 14 points—so text can be read easily
on the screen. Use no more than two or three different fonts. Consider using a
sans serif font, such as Arial or Helvetica, for paragraph text.

e Keep pages short. While some vertical scrolling is acceptable, if a page is longer
than two or three screens, consider breaking it up into shorter pages. Some
instructors find it useful to think of each page as a chunk of information or a brief
lesson.

Remember ALL of Your Students

Make sure your content is accessible and can be used by students who rely on
adaptive technology to navigate your course. Here are some accessibility fips:

11 Nielsen, Jakob. “How Users Read on the Web." useit.com. Nielsen Norman Group. 1 Oct. 1997. Web. 22
Sept. 2009.



Student Experience: Best Practice: Remember the Student

e Use a white background with dark text—the most readable color combination. If
you choose to use a colored background, select a light color to maximize
confrast between the page and the text. Avoid dark pages or loud colors, such
as bright red, green, or yellow. These color choices cause eye fatigue, obscure
text with glare, and are difficult to read.

e Do notrely on color alone to relay key information because color is not
accessible to all students. Instead, use bold or different font sizes for emphasis.

e Use the alt attribute with images. The alt atftribute provides alternative
information about images and can be read by text-based browsers and screen
readers. The alt attribute also allows students on slower modems to see an
image's description or label while they wait for it to load.



3.0 Creating Your Course Menu

In this section, you will turn to the instructor perspective and explore the process of
planning, adding, and organizing links on the Course Menu. You will gain hands-on
experience creating a Course Menu suitable for your course. Finally, you will develop a
Getting Started Content Area designed to provide students with the information they
need to be successful learners.

Learning Outcomes

After completing this section, you will be able to:

Explain the difference between the instructor and student views of the course
Explain the steps for creating a Course Menu

Create the Course Menu, adding links to tools and Content Areas

Describe different strategies for planning Content Areas

Create a Content Area and add items and tools to it

Edit and order links on the Course Menu



Overview

As you have seen, students use the Course Menu to access tools and materials. It is the
cornerstone for the organization and navigation of a course. Because it reflects the
high-level organization of your course, devote ample time to creating your Course
Menu.

There are four overall steps in creating the Course Menu. You will use these as a
checklist as the process is presented.

Four Steps to Course Menu Creation:

1. Plan the Course Menu links

2. Add the tools and Blank Pages
3. Create the Content Areas
4

Organize the Course Menu links



Planning the Course Menu Links

STEP 1: Plan the Course Menu Links

Before adding links to the Course Menu, take a step back and look at your course
material, learning objectives, and activities.

A good initial strategy is to keep the Course Menu as simple as possible.
The following table suggests possible starting points for determining what to add to the

Course Menu.

¥ If you want to provide ¥ Add

One-click access to regularly used tools, such as Tool Link to the specific tool
the Discussion Board, Blogs, or Calendar

Lecture notes or other reading material One or more Content Areas
to organize the material

A link to a regularly used Web site External Link

An important file, such as a checklist, map, or Blank Page
image to which students need regular and easy
access




About Edit Mode

As the Course Menu is created, you will work in Edit Mode. Edit Mode allows you to view
all the instructor functions.

NOTE: In this workshop, the phrase *in Edit Mode” refers to Edit Mode being ON, showing
all the instructor’s functions.

Earth System Science Assignments

Esit Moce: LT |

rjn

# Earth Sysiem »
Science .

I Home Page
1 Getting Started

4 4

i

T Weelk
1 Assignments

LU

1 Discussions
1 Course Blog
1 Earth Science Yeh Sites
1

<%

1 Groups 3

a
1 Tools ¥
L N

F

¥

Assignments =

Build Content ¥ LGLRDICTETA AR LIRS | Discover Content || T4

A

A

Worksheet 1
attached Fles [ Worksheet 1 (26.5 KB)

Diowenload the attachment, add your responses, and upload to this assignment with your
last name added to the file name.

This assignment is worth 25 paints.

Term Paper Requirements and Topic Submission

The papertopic needs to have greater depth than the cowerage the topic receives in class.

The paper needs to include the writer's own conclusions and not he a repeat ofwhat is

Figure 1 - Instructor view of the Course Menu and a Content Area

» Take Note

A. Click Edit Mode to change from ON to OFF. When Edit Mode is ON, all instructor
functions are available. When Edit Mode is OFF, you see what students see.

B. When Edit Mode is ON, the Course Menu’s Add Menu Item function is available,
which is shown as a plus sign. Use this function to add links to the Course Menu.
Whenever you add a new link to the Course Menu, it will appear at the bottom
of the list. You will learn how to reorder the links later in this manual.
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Adding Tools to the Course Menu

STEP 2: Add the Tools and Blank Pages

Links to frequently used tools can be added to the Course Menu. Consider the course
content and the needs of the students when adding tools.

b Elf=! e v T
Add Tool Link

e Name: Courze Calendar
» Create Content Area
e

» Create Blank Fage -
(u) - Tool is™
1 | » Create Tool Link e
1 | » Create Course Link Available to Users
I 4 » Create External Link
» Create Module Page e m

1

I' » Create Subheader
I. » Create Divider

!

*
1 Groups ¥
I Tools ¥
Figure 2

» QUICK STEPS: adding tools to the Course Menu
1. In Edit Mode, point to the plus sign above the Course Menu. The Add Menu ltem
drop-down list appears.
Select Create Tool Link.
Type a Name for the link.
From the Type drop-down list, select the tool fo add.
Select the Available to Users check box.

Click Submit.

o0 kDN

NOTE: In the drop-down list, you may not see Create Blank Page. This is not a default
option, but can be added by the instructor. Tool availability is discussed in the
Customizing Your Course section of this manual.
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Adding Blank Pages to the Course Menu

STEP 2: Add the Tools and Blank Pages, continued

You can add important information students need easy access to by adding it to the
Course Menu using the Blank Page tool. The Blank Page tool allows you to add files,
images, and text as a link on the Course Menu.

Add Blank Pages to the Course Menu for critical information, as too many links on the
Course Menu can overwhelm students. Remove Blank Pages from the Course Menu as
soon as the information is no longer needed.

The following list includes uses for adding Blank Pages to the Course Menu:

e Add a map image for an upcoming field trip
e Add information and a photo for a guest speaker
e Add a checklist of reading materials and Web sites to visit before a chat session

e Add a study guide for the final test

TIP: Alternatively, you can also add a Content Area fitled New and Important and fell
your students to check this Content Area first when they log in to your course each
time. Any of the information in the preceding list can also be added to the appropriate
Content Area and you can inform students in an announcement. As you can see, you
can find multiple ways to present course content to students.



Creating Your Course Menu: Adding Blank Pages to the Course Menu

» QUICK STEPS: adding a Blank Page to the Course Menu
1. In Edit Mode, point to the plus sign above the Course Menu. The Add Menu ltem
drop-down list appears.
Select Create Blank Page.
Type a Name for the link.

Select the Available to Users check box.

AR S

Click Submit. The Edit Blank Page appears in the content frame and the new
Blank Page link appears last on the Course Menu.

6. Information can be added to the Blank Page aft this time or click Cancel to add
information later.

Od g X% B OO0 g X —
L Cantent Area Add Blank Page

» Create Blank Page
» Create Tool Link

| » Create Course Link
# Create External Link
» Create Module Fage
» Create Subheader
» Create Divider

+ Mame: [Field Trip Map 3

Available to Users

o Cancel |

Figure 3

Adding information to a Blank Page is similar to adding information to an itemin a
Content Areq, which is discussed later in this manual.
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Hands-on Activity @

For this activity, use your Practice Course.

Start building the Course Menu.
Add Tools and a Blank Page to the Course Menu

e Add the Blogs and Calendar tools to the Course Menu.
e Add other tools appropriate for your course.

e Add a Blank Page to the Course Menu, if it has been enabled. You do not need
to add the actual information to the page at this time, but feel free to
experiment with this tool.

© 2009 Blackboard Inc. -34 - Getting Started



Creating the Content Areas

STEP 3: Create Content Areas

Typically, courses contain multiple Content Areas. Content Areas are containers for
several pieces of content, such as lecture notes, assignments, tests, tools, links to Web
sites, and other materials.

An instructor can delete or edit the default Content Areas and create new Content
Areaqs.

The following table lists the four substeps for creating Content Areas.

STEP 3: Create Content Areas

THE FOUR SUBSTEPS

» Determine how the Content Areas will be organized

k Add the Content Areas

Pk Add items and tools to the Content Areas

¢ Edit the items in the Content Areas




Determining the Content Organization

In the following table, the arrow image indicates which substep is being described.

STEP 3: Create Content Areas

THE FOUR SUBSTEPS

» Determine how the Content Areas will be organized

Add the Content Areas

Add items and tools fo the Content Areas

Edit the items in the Content Areas

Content can be organized in Content Areas in various ways. Three common
approaches include chronologically, by content type, and by subject area.



Creating Your Course Menu: Determining the Content Organization

Organizing Content Areas Chronologically

In this approach, each Content Area contains a week's worth of readings, assignments,
lecture notes, and discussion forums. A Getting Started Content Area contains
information about course policies, a syllabus, and other information students need at
the beginning of a course.

= R B =

# Earth System Sl:iem:eg s

Home Page
Getting Started

YWeelk 1
Week 2 o
Week 3

Figure 4.1

* Take Note

A. Content Areas can be created ahead of time, made unavailable, and then
made available at the appropriate time. In the preceding example, Weeks 1
through 3 can be created and made unavailable until each is needed.
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Creating Your Course Menu: Determining the Content Organization

The following image represents how Content Areas can be organized chronologically.

Course Policies

Gelting Started % syllabus

Week | lcebreaker Forum

Week 2

Week 3 e Readings

Lecture Motes

Course Menu
SDalY JUajuoD)

Toaols Assignment
Self Test

Figure 4.2
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Creating Your Course Menu: Determining the Content Organization

Organizing Content Areas by Type of Content

In this type of organization, related types of content are grouped together in a Content
Areaq, such as all the lectures for the entire course. A Content Area can contain multiple
items and multiple folders.

# Introduction to

Alternative Energy
Home Page

Lectures

Readings

Assignments

Figure 4.3

The following image represents how Content Areas can be organized by type of
content.

Course Policies
syllabus
lcebreaker Forum

Getting Started
Instructor Info

Lectures

V4

Topic 1 Lecture
Topic 2 Lecture

Blogs

Topic 3 Lecture

Journals

Course Menu
SDalY Juajuod

Topic 1 Readings

Readings
Topic 2 Readings

l

Topic 3 Readings

Figure 4.4
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Creating Your Course Menu: Determining the Content Organization

Organizing Content Areas by Subject Areas

When content is organized by subject area, each Content Area contains lecture
material and readings on a specific subject, along with assignments, discussion forums,
and assessments.

native Energy
Home Page
Getting Started
Solar
Wind
Biofuels
Figure 4.5

The following image represents how Content Areas can be organized by subject area.

Course Policies
Getting Started Syllabus

lcebreaker Forum

Readings
Lecture Notes
Assignments
Self Test

Course Menu
SDalV Jusjuod

Lecture Notes
Assignments
Chat Session
Test

Figure 4.6
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Adding a Content Area

Once the method of organization is decided, you are ready to add the Content Areas.
A Content Area starts as an empty container. Course materials and tools will be added
in the next step.

In the following table, the arrow image indicates which substep is being described.

STEP 3: Create Content Areas

THE FOUR SUBSTEPS

Determine how the Content Areas will be organized

» Add the Content Areas

Add items and tools to the Content Areas

Edit the items in the Content Areas




Creating Your Course Menu: Adding a Content Area

» QUICK STEPS: adding a Content Area

1. In Edit Mode, point to the plus sign above the Course Menu. The Add Menu ltem

drop-down list appears.

Select Create Content Area.

Type a Name for the new Content Area.
Select the Available to Users check box.

Click Submit.

AR S

S]] o ﬂl I i
Add Content Area

e Mame! | Getting Started e,
Auwailable to Users

Cancel | Submit

» Create Caontent Area
» Create Tool Link

» Create Course Link
» Create External Link
» zreate Module Page
» Create Subheader
» Create Divider

Figure 5

TIP: Content Areas can be created and made unavailable to users until needed.
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Hands-on Activity @

For this activity, use your Practice Course.

Planning Content Areas

e Take a few minutes to consider how you will organize your online course. List the
Content Areas to include in the Course Menu.

Adding Content Areas

e Create two or three Content Areas suitable for your course and subject matter.
Title one of them Getting Started.

Viewing Content Areas

¢ On the Course Menu, note the Content Areas you created. Since the new
Content Areas are empty, a dofted square appears next to the name. Empty
Content Areas will not appear in the Course Menu in student view.

e Access the Getting Started Content Area. Note that it is empty. You will add
materials to it in the next section.

e Use the breadcrumbs to return to the course entry point, which is
Announcements for this course. Changing the course enfry point is covered later
in this manual.



Adding Items and Tools to a Content Area

In the following table, the arrow image indicates which substep is being described.

STEP 3: Create Content Areas

THE FOUR SUBSTEPS

Determine how the Content Areas will be organized

Add the Content Areas

k Add items and tools to the Content Areas

Edit the items in the Content Areas

You have added Content Areas to the Course Menu. The next step is to add course
materials and tools. The following list includes some of the items that can be added to
Content Areas, if they have been made available to your course:

e Items, which can contain text, audio, movies, files, and images

Individual tool links, Course Links, and URLs

e |Individual audio, image, and video links

e Folders, Learning Modules, and Lesson Plans
e Assignments, tests, and surveys

e Mashups

e Blank Pages

e Textbook information

NOTE: A Mashup can be defined as combining elements from two or more sources.
When you view a YouTube™ video in a Blackboard Learn course as part of the course
content, you are experiencing a Mashup. Mashups can also include Flickr® photos and
SlideShare presentations.



Creating Your Course Menu: Adding Items and Tools fo a Content Area

7 Week 1
Build Content ¥ Add Interactive Tool %% || Assign Textbook 3% T

Figure 6.1

On the Action Bar, use the Build Content, Create Assessment, Add Interactive Tool, and
Assign Textbook options to add materials to Content Areas.

The system administrator determines if other functions and tools are available to your
course. Instructors also have the capability of determining tool availability in their
courses. Tool availability will be discussed later in this manual in the Customizing Your
Course section.
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Creating Your Course Menu: Adding Items and Tools to a Content Area

The following table summarizes the materials that can be added using each option on
the Action Barin a Content Areq, if they are available in your course.

¥ Content Area additions

¥ Click

ltem, file, or folder

e URL, Audio, Image, Video

e Learning Module

e Lesson Plan

e Syllabus

e Course Link

e Module Page or Blank Page

e Mashups

Build Content

o Test

e Survey

e Assignment

e Self and Peer Assessment

e SafeAssignment

Create Assessment

e Discussion Board
e Blogs

e Journals

o Wikis

e Groups

e Chat or Virtual Classroom sessions

Add Interactive Tool

e Textbook information for your course

Assign Textbook

The steps for adding items and tools are next. Other types of content can be added in

a similar fashion.



Creating Your Course Menu: Adding Items and Tools to a Content Area

Adding Items to Content Areas

An item can contain text, audio, movies, files, images, and Mashups. If text is added, it
can be formatted using the Text Editor functions.

» QUICK STEPS: adding items to Content Areas

1.

2
3.
4

In Edit Mode, access the Content Area from the Course Menu.
On the Action Bar, point to Build Content to access the drop-down list.
Select Item from the Create column.

On the Create Item page, type the item’s Name and select a color for the
name, if you want. Add optional instructions or a description in the Text box.
Format the text using the Text Editor functions, if you want.

To add a file, click Browse My Computer or Browse Course Files to locate the file.
Add a Link Title for the attached file; otherwise the file name appears in the
Content Area. Alternatively, you can use the Attach File function in the Text
Editor.

Under Options, select Yes for Permit Users to View this Content to make the item
available to students. Select other options as needed.

Click Submit.

NOTE: In the Build Content drop-down list, additional content types are listed. Notice
that Files, Audio, Image, Video, URL, and Mashups are listed, but can also be added
using the Text Editor functions when adding a content item. The student view may be
different depending on the method used, so experiment to determine which method
meets your needs.
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Creating Your Course Menu: Adding Items and Tools fo a Content Area

7 Week 1~

Build Content % 2 _:te
Create

> Item o

> File

Create Item

M Indicates a required field.

Cancel
1. Content Information
# Mame |Chapter1 Study Guide |
Color of Mame . ¥ Black o
Text visual Editor: [0 ]

‘lNormaI v| |3 v||.0.rial v| | B I U ake| x x2||§
Y DN & v QO SALS | IO OoOE
“BEORE BB

Download the attached doc to help you organize the materials for this chapter. Also find
some helpful studying hints other students have contributed over the years.

| path: body

Aftach File Browse My Computer | Browse Course Files |

Attached files

File Name Link Title File Action
[ chapter! _study_guide.doc Chapter 1 Study Guide Create a link to this file Do not attach

=Bl oOptions

Permit Users toYiew @ Yes (O Mo 6
this Content

Track Mumber of ) Yes G Mo

igws

Select Date and Time 7] DisplayAﬂer| | | |@|

Restrictions [] Display Unti|| | | |@|
Figure 6.2

NOTE: Under Attachments, the Browse Course Files function takes you to a central
storage location on the Blackboard server that is accessed directly from the course.
Instructors can upload files to Course Files and link to them when creating course
content. Within each course, Course Files displays content for that specific course, not
for other courses taught by the instructor. Any file uploaded from your local computer
using the Browse My Computer function is automatically added to Course Files. This
repository is not seen by students, but is available to instructors when adding content or
by accessing Files in the Control Panel. Course Files is discussed in-depth in the manual,
Using Course Files.
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Creating Your Course Menu: Adding Items and Tools to a Content Area

Exlit Mo m

7 Week 1~
Build Content % Add Interactive Tool %% || Assign Textbook 3% T

1 Reading Materials =
Attached Files j Reading for Chapter 1 (26.5 KB)

1 Chapter 1 Study Guide =
Aftached Files [ Chapter 1 Study Guide (26.5 KB

Flease allow at least three hours to fully understand this information.

Dowenload the attached doc to help vou arganize the materials for this chapter. Also find some
helpful studyving hints other students have contributed over the years.

Figure 6.3 - Instructor view of a Content Area containing two items, each with a file attached

Adding Tools to Content Areas

You learned earlier how to add tools directly to the Course Menu. A tool can also be
added to a Content Area for students to use in conjunction with the content contained
there. For example, if students will be creating Blog entries related to the content, add
the Blogs tool.

» QUICK STEPS: adding tools to Content Areas

1.

o0 kDN

In Edit Mode, access the Content Area.

On the Action Bar, point to Build Content to access the drop-down list.
Select Tools Area from the New Page column.

On the Link to Tools Area page, select the tool and click Next.

On the Create Link page, type a Link Name or leave the default name.

In the Text box, type the text to appear under the link name in the Content Area.
Format the text using the Text Editor functions, if you want.

Under Options, select Yes for Available fo make the tool available to students.
Select other options as needed.

Click Submit.
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Creating Your Course Menu: Adding Items and Tools to a Content Area

7 Week 1

Build Content %

:te Assessment %

Create Hew Page

» Iterm » Content Folder
> File » Blank Page

> Audin » Madule Page

> lmage » Tools Area

Link to Tools Area

8 Link to Tools Area
Tools ) Ahhouncements
(& Blogs
() Calendar
o (O Collaboration
) Contacts

() Content Area

(" Discussion Board
(" Email

() Glossary

O Groups

O Journals

"y Manual

() Messages

O iy Grades

) Roster

O Student Ohjectives
() Tasks

O Tools Area

Figure 6.4 - Add a tool o a Content Area using the Build Content function on the Action Bar

reate Link: Blogs

Edit Mode: [ELN | % |

Create Link: Blogs

* Indicates & required figld.

1. Link Information

(2]

+ Link Mame

[Blog: Earth Science in the Mews

Color of Mame

B Bk

Link Tool: Blogs
Text
‘l Mormal W | | 3 V| | Arial

‘hEAREBE

¥ [ B I U ae| % <

cAc A InE 2 v QEAJAS AR OOS

visual Editor: [JELNL_]

|;: 3 +
f= =

i
il
hl|
;s

Click the link ahove to be taken ta the main Blogs page. Click the appropriate Elog title and
followy the instructions. This iz a graded submission warth 25 points.

“| path: body

BN Options ; 4

-I @ Yes O Mo

Track Mumber of Yievws O Yes @ Mo

Available

Diste Restrictions [ Display Adter |

=

[] Display Unil |

G

| = I

Figure 4.5 - The Create Link page
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Creating Your Course Menu: Adding Items and Tools fo a Content Area

7 Week 1~
Build Content % Add Interactive Tool %% || Assign Textbook

1 Reading Materials =
Attached Files j Reading for Chapter 1 (26.5 KB)
Flease allow at least three hours to fully understand this information.

1 @ Blog: Earth Science in the News 6

Click the link above to be taken to the main Blogs page. Click the appropriate Blog title
the instructions. This is a graded suhmission worth 25 points.

Figure 6.6 — Instructor view of a tool added to a Content Area
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Accessing Page Help

In many areas, you can access Page Help, unless your system administrator has
disabled it. Turn Page Help on and off next to the Edit Mode function by clicking the
question mark.

Ecit Mocke: [N | 2 || | Esitmoce: [EIN (R

Figure 7

Information about the specific content you are working with is available at the top of
the screen. You may also find additional information on the screen where you may
need instructions for a field, such as how to type dates or remove an attachment. If no
question mark appears, Page Help is not available.
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Hands-on Activity @

For this activity, use your Practice Course.

One of the most anxiety-provoking points in an online student’s experience is
wondering where to begin. Help ease your students’ concerns by giving them a clear
starting point. To provide students with the information they need to get started on the
right foot, flesh out the Getting Started Content Area you created earlier.

Add material to the Getting Started Content Area

Add an item titled Course Policies.

Use the Build Content drop-down list to create a Syllabus. On the Add Syllabus
page, turn Page Help on and click the More Help link to access more information
about creating a syllabus. Page Help will open in a new window and can be
moved to a new screen location.

Return to the Add Syllabus page and select the option to Create New Syllabus.
Do not create the lesson shells, as they will be created in a later activity.

Add a link to the Discussion Board. A Getting Started forum will be created later.
Hint: Use the Add Interactive Tool drop-down list.

Add a URL for a Web site related to your course.

Turn Edit Mode to OFF. On the Course Menu, click the Getting Started link to
preview how the Content Area will appear to your students.
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Editing the Items in a Content Area

In the following table, the arrow image indicates which substep is being described.

STEP 3: Create Content Areas

THE FOUR SUBSTEPS

Determine how the Content Areas will be organized

Add the Content Areas

Add items and tools to the Content Areas

k Edit the items in the Content Areas

After items are added to a Content Area, you can edit the following:

e Theitem’s name
¢ The item’s availability

e The order of the items



Creating Your Course Menu: Editing the Items in a Content Area

Edit an ltem’s Name or Availability

7 Week 1~

1 Reading Materials
attached Files [ Reading X

» Edit

Create Aﬂer"""-.l I

Flease allow at [east thi
» Adaptive Helease

1 Blog: Earth Scienc| * Adaptive Release: Advanced
Click the link above to b » Set Review Status(Disahled)
the instructions. This is

» Metadata
» Btatistics Tracking (Onfc
! . Chapter 1 Study G g (On/om
# Uzar Progress
Aftached Files [ Chapten
» Copy

Diowenload the attached
helpful studying hints ot * Delete

Figure 8.1

» QUICK STEPS: editing an item in a Content Area
1. In Edit Mode, in the Content Areq, click the item’s Action Link fo access the
contextual menu.
2. Select Edit.

3. Edit the item’s Name or availability. If a content item has been added, edit the
actual content, if you want.

Make an item unavailable if content is still being developed, needs updating, or if the
item is not yet needed by students.
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Creating Your Course Menu: Editing the Items in a Content Area

Change the Order of Items

Add content items to a Content Area in any order and reorder using the drag-and-
drop function. Each item has a move icon—a double-tipped arrow or handle.

» QUICK STEPS: changing the order of items in a Content Area

1. In Edit Mode, press the arrows next to the item. The item is highlighted.

2. Drag the item into the new location in the Content Area. The item is surrounded
by dashes as it is being moved into its new spot.

3. Release the item to place it in its new location.

I Chapter 1: The History of Ocean Exploration and Ocean
Science

This chapter introduces you to the history of ocean exploration and
science, starting with the earliest evidence of ocean travel and ending
with our present ideas and technology for ocean science and exploration.

c&p History of Ocean Exploration

After reading and reviewing all of the material in Chapter 1, please
complete this assignment.

i B Chapter 2: Beginnings of the Universe, Earth, and Life

In this chapter, you will explore how the composition of our planet has
changed over time, and whether or not the existence of an ocean was
essential to the origin of life.

Figure 8.2

History of Ocean Exploration
After reading and reviewing all of the material in Chapter 1, please

complete this assignment.

Chapter 1: The History of Ocean Exploration and Ocean
Science

This chapter introduces you to the history of ocean exploration and
science, starting with the earliest evidence of ocean travel and ending
with our present ideas and technology for ocean science and exploration.

I B Chapter 2: Beginnings of the Universe, Earth, and Life

In this chapter, you will explore how the composition of our planet has
changed owver time, and whether or not the existence of an ocean was
essential to the origin of life.

Figure 8.3
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Creating Your Course Menu: Editing the Items in a Content Area

Reorder with the Keyboard Accessible Reordering Tool

ltems can also be reordered using the Keyboard Accessible Reordering tool.

» QUICK STEPS: using the Keyboard Accessible Reordering Tool

1. In Edit Mode, in the Content Area, click the Keyboard Accessible Reordering tool
on the Action Bar.

Click the item in the list to select it.

Use the up and down arrows below the title box to adjust the order.
Click Submit. A pop-up box states: ltems have been reordered.
Click OK.

Week 1 =

Build Content ¥ Add Interactive Tool % | Assign Textbook ¥ gt

Reorder: Content

! ~  Week 1 Readings © lterns
) Week 1 Readings
Attached Files Lecture and Readings (26.5 KB)

Identification Exercise

o A~ 0N

[ i

Please allow two to three hours to camp
i Identification Exercise =
Attached Files  [jMeek 1Workshest (26 5 KE)

Figure 8.4

<

Cancel Submit
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Hands-on Activity @

For this activity, use your Practice Course.

Materials and tools have been added to the Getting Started Content Area. Now
choose the order for the contents.

Organize the Content Area ltems
e On the Course Menu, access the Getting Started Content Area. Be sure Edit
Mode is ON.
e Change the name of the Syllabus.
¢ Make the URL unavailable.

¢ Use the drag-and-drop function or the Keyboard Accessible Reordering tool to
change the order of the materials.
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Organizing the Course Menu Links

To review, there are four steps to Course Menu creation:

1. Plan the Course Menu links

2. Add the tools and Blank Pages
3. Create the Content Areas
4

Organize the Course Menu links

We will now cover the final step.

STEP 4: Organize the Course Menu Links

You can organize the Course Menu links to make them easier for students to use.

e Order the links using the drag-and-drop function or the Keyboard Accessible
Reordering tool.

e Rename a link and change its availability.
e Add subheaders and dividers.



Creating Your Course Menu: Organizing the Course Menu Links

In the following Course Menu, the instructor organized the content into sections and
added the following subheaders: Content, Course Tools, and Contacts. The Week 2
Content Area was made unavailable to students and the Contacts tool was renamed
Instructor Bio.

=

EloCe N
# Earth System

Science
Home Page

44

44

Content
Getting Started
Weeak 1
Weaek 2 &
Assignments

] = = = -
o & « «
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Cowrse Tools

&

Discussions

L4

Blogs

=
L4

Calendar

Contacts
Instructar Bio

Class Roster
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Figure 9.1
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Creating Your Course Menu: Organizing the Course Menu Links

Reorder and Make Links Unavailable

=
SR Reor der: Mens tems
Science
. [terms
Home P
1 Homs Page Getting Started 2 -
I co Week 1 # Earth System o
II% Yeek 7 = ; Science o
= e A [ Home Pa
! Assignments ge
1 wie Subheader. Course Tools ¥ . Build Content
d - 1 Content '
I weekz¥ s -
' 1T Getling Started
I Assignments [ Cancel ]I Submit ] . T .
- T Week =
I roawse Tonls {1 R P
1, Week2 @ » Rename Link
I. Assignments » Hide Link
1 cowrse Tools » Permit guests
I -
1 Discussions * Delete
Figure 9.2
> Take Note

A. Use the drag-and-drop function to reorder links on the Course Menu.
B. Alternatively, use the Keyboard Accessible Reordering tool to reorder the links.

C. Click alink's Action Link and select Hide Link to make a link unavailable to
students.

NOTE: In Edit Mode, an unavailable link title appears with a square with a diagonal line
through it. Students will not see the link on the Course Menu.
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Creating Your Course Menu: Organizing the Course Menu Links

Add Subheaders and Dividers

You can group your Course Menu links and add subheaders to each group of content
to help students navigate in your course. Each subheader added appears with a
divider line to help visually organize the links. You can also add individual divider lines,
for example, if you choose not to add subheaders. The divider lines can be used to
separate the links into areas.

» QUICK STEPS: adding a subheader to the Course Menu
1. In Edit Mode, point to the plus sign above the Course Menu. The Add Menu ltem
drop-down list appears.
2. Select Create Subheader.
3. Type a Name.

4. Click Submit. The Subheader is added to the bottom of the Course Menu and
can be dragged into place.

[ [ iy g 00 g i ]
» fontent Area Add Subheader

» Create Blank Fage
. % Mame: |Caurse Cantent
» Create Tool Link

> Create Course Link Cancel |

i * Create External Link
» Create Module Page
» Create Subheader

» Create Divider

Figure 9.3

A Divider is added from the Add Menu Item drop-down list also. The Divider is also
added to the bottom of the Course Menu and can be dragged into place.
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Creating Your Course Menu: Organizing the Course Menu Links

Rename Links

» QUICK STEPS: renaming a link

1. In Edit Mode, click the item’s Action Link to access the contextual menu.
2. Select Rename Link.

3. Type a new name.
4

Click the check mark to Save or the X to Cancel. The new name appears on the
Course Menu.

¥ %
slooe ]
é»

# Earth System
Science

B ¥ # Earth System
Science
Build Content

Home Fage Home P

Content
Getting Started

| Content

. [Introductory Materials]| %

o k= | — N o X
YWeelk 1 x Wieek 1 ¥
i Week 2 » Renarme Link
Assignments » Hide Link
Course Tools » Parmit guests
I
Discussions » Delete
Figure 9.4
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Hands-on Activity E

For this activity, use your Practice Course.

Finalize the Course Menu by making any changes to the link order, link names, or
availability of links.

Edit the Course Menu Links
e Change the order of the links on the Course Menu by using the drag-and-drop

function or the Keyboard Accessible Reordering tool.

e Change the name of the Information Content Area. NOTE: Leave the other links
as they are. They are needed in future activities.

¢ Make one of the links unavailable to students. Notice the unavailable icon
appearing next to the link title.

e Turn Edit Mode to OFF and view the Course Menu as students will see if.



Ask Dr. C 5.}]

In the following table, Dr. C discusses Course Menu organization. Dr. C is our Blackboard
Learn expert.

¥ Your question ¥ Dr. C's reply

| have a lot of course content to A streamlined and uncluttered Course
deliver fo my students. What is an Menu is ideal. Including too many links on
effective way to organize the the Course Menu can overwhelm students.

Course Menue¢ )
To streamline the Course Menu:

e Include no more than six to eight
primary links on the Course Menu.

e Use subheaders or dividers to organize
confent.

e Hide any content students will not be
using immediately. As the term
progresses, infroduce these additional
links.




Ask Dr. C 5.}]

In the following table, Dr. C discusses student access to course tools.

¥ Your question

¥ Dr. C's reply

Should students access
tools individually on the
Course Menu, ina
Content Areq, or from
the Tools link?2

It is a good practice to make unused tools unavailable
and only show tools when they are needed.

Deciding where to put tools depends on the situation.

Method 1: Access individual tools from the Course
Menu. This method provides quick access to frequently
used tools. Make the Tools link on the Course Menu
unavailable so students cannot access other unneeded
tools.

Method 2: Access individual tools from a Content Area.
This method can provide tools near related content. For
example, if students are to read an item in the Content
Area and then respond on the Discussion Board, add a
Tool Link in the Content Area for easy Discussion Board
participation.

Method 3: Access tools from the Tools link on the Course
Menu. Consider using this method to quickly set up a
course. It may be appropriate for a course that
supplements a face-to-face class and provides tools for
online communication outside of the regular classroom.



4.0 Customizing Your Course

In this section, you will learn about the choices for the Course Menu and other aspects
of your course. You will start by customizing the course style and choosing the default
Course Menu and content view. Next, you will select the most appropriate page for the
course entry point for your learners and customize it by adding a banner. You will also
select which tools will be available to course members. Finally, you will customize the
Home Page by adding, removing, and reordering modules.

Learning Outcomes
After completing this section, you will be able to:

e Explain the features and functions of the Conftrol Panel

e Customize the course style

e Select a content view

e Select the page for the course entry point

e Add a banner to the course entry page

e Change tool availability

e Customize the Home Page by adding, removing, and reordering modules

e Edit the notification settings



The Control Panel

Customize your course using the customization options on the Conftrol Panel. The
Control Panel is the central access point for course management functions and is not
visible to students. The Control Panel is located under the Course Menu.

S0 g %
# Earth System *
Science
1 Home Page
Getting Started

Ll 5 4

1 Week 1
Discussions

LA AR A« 4

Assignments

1 Tools

EEE |

1 Field Trip Map

LA AT 4

# Control Panel

‘W

Kﬁﬁ‘\t‘iﬁiﬁi‘h

# Zustomization

b |

igure 1

» Take Note

>

2 Customization

iw

Enroliment Cptions

Guest and Ohserver Access
Properties

Style

Tool &vailsbility

A. Expand each of the items on the Control Panel by clicking the double arrows
pointing downward. The menu appears directly below the subheading. Select
the option.

B. Alternatively, expand an item into the content frame by clicking the double
arrows pointing right. Select an option.
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Customizing the Course Style

Select Style from the Customization section of the Control Panel to customize the menu
style and display, the default content view, the course entry point, and add a banner.

# Customization L » b
Enrallinent Options Style
Guest and Obzerver Access
Froperties Cancel m

Style ’ Ml Select Menu Style
Tool 2vailability

Preview « Earth System Science

(earth_sys sci 104)
henu [term 1

henu tem 2

henu [term 3

Style (%) Text (O Buttons

Background J@

Calar

Text Caolar . Black

vJl Course Menu Display

Default Menu View T FolderView & ListView
Permit Both Views

<M Default Content View
Content View (7 lcon Only (7 Text Only (& leon and Test

'S8l Select Course Entry Point

Entry Point ‘Home Page ™
Home Page

Getting Started

5 . Week 1
Current Banner Discuszsions
lmane Tools
Course Checklist
Mew Banner Aftach File Browse My Computer

Image

Figure 2
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Customizing Your Course: Customizing the Course Style

» Take Note
Customize the course style in the following ways:
Display the links on the Course Menu as text or buttons.

Select a default view for the Course Menu — either Folder View or List View.

Select a default content view —Icon Only, Text Only, or Icon and Text.

O 0O m >

Change the course entry point. The course entry point is the first page students
see when entering the course. The default course entry point is the Home Page.
Select the new entry point from the drop-down list. Any link that appears on the
Course Menu can be the course entry point.

E. Add abanner to the top of the course entry page. The banner can be a text
phrase or an image. The image needs to be in .png or .jpg format and
approximately 480 x 80 pixels.

NOTE: Banner images must be uploaded from your local computer; however, a copy is
stored in Course Files with each new upload. If you delete the image from the course
entry page, the image file remains in Course Files.



Ask Dr. C 5.}]

In the following table, Dr. C discusses image formats.

¥ Your question ¥ Dr. C's reply
What type of image Two good graphic formats for use on the Web are
format is best to use for .png and .jpg.

my bannere ) )
e A .pngis good for full colorimages, logos, and

illustrations.
e A .png retains image detail.

e A .png can be transparent, which means non-
rectangular shapes can appear over a
background pattern.

e Be aware that some older browsers do not support
the .png format.

e A jpgis usually a better file format to use for
photographs or images in which there are subtle
gradations.

e For photos, .jpgs will compress to a smaller file size.
However, if the file compression is foo high, you
can lose quality.

e A .jpg can never be fransparent.




Changing Tool Availability

You can select which tools are available in your course and which users have access to
them. For example, if the Messages tool will not be used, make it unavailable. No one
can see it or access it, including the instructor, until it is made available again. Available
tools are listed alphabetically on the Tool Availability page.

NOTE: The system administrator can turn off select tools, making those tools unavailable
for use in your courses. The system administrator can also remove the instructor’s ability
to choose who has access to select tools.

Tool State Description of State

The tool is available throughout the course and open to all
users having a role permitting use of the tool.

The tool is visible (read-only), but not usable to Guests, when

DIE 10 = Guests are permitted into the course.
ble to The tool is visible (read-only), but not usable to Observers,
Observe when Observers are permitted info the course.

The instructor can place a link to the tool in one or more
ontent Areq Content Areas in the course.




Customizing Your Course: Changing Tool Availability

If a tool is made unavailable, the tool’s content is not deleted. Once the tool is
available again, the content becomes available.

* QUICK STEPS: changing tool availability

1. On the Control Panel, select Customization.

2. Select Tool Availability.

3. On the Tool Avdilability page, make the availability adjustments required.
o To make a tool Available, select the tool's check box.
o To make a tool unavailable, clear the tool's check box.

4. Click Submit.

Cancel m
Tool .~ Available Visible to Guests Visible to Observers Available in Content Area
Adzptive Releaze = =
Announcements
Azzignment - - -
Audio - - -
Blackboatd Scholar = =
Bllank Page - - -
Blog - - -
Figure 3
LEGEND:

Filled check box: system administrator made the tool unavailable.

Hyphen: availability settings in the system cannot be changed.
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Ask Dr. C 5.}]

In the following table, Dr. C discusses two course roles: Observers and Guests.

¥ Your question ¥ Dr C's reply

Who might be an Observer In addition to your students, Guests and Observers
or Guest in my online may be enrolled in your course.

course?

Guests can be prospective students, guest
lecturers, or others with limited access.

Observers are connected to an individual student
account, such as an advisor who works with one of
your students.




Hands-on Activity @

For this activity, use your Practice Course.

Make the following customizations:

Course Menu and Content View

e Change the menu style to button links and select a new color and shape.

e Change how links are viewed on the Course Menu to Folder View, but permit
users to select either view.

Course Entry Point

e Change the course entry point to the Getting Started Content Area.

Course Entry Page Banner

e Add a banner for your course. You may add one you have made or found.
Alternatively, access the Workshop Resources Content Area and download the
banner.zip file fo experiment with one of the provided banner images.

e Access the Files area in the Control Panel to see that the image was added to
Course Files.

Tool Availability

e Make the Glossary tool unavailable. Note how the Glossary link on the Course
Menu now has the hidden icon next to it. Change the availability of one other
tool not needed. Expand the Course Tools section of the Control Panel and note
that Glossary and the other tool are not in the list.

e Turn Edit Mode to OFF. On the Course Menu, select Tools and preview how this
page appears to students.

e Turn Edit Mode to ON and make the tools available again.
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Customizing the Home Page

Earlier, you explored the student view of the Home Page. The Home Page is a Module
Page, which is a specialized content page that presents information in discrete boxes.
By default, a new course's Home Page contains the following modules:

¢ My Announcements
o My Tasks

e What's New

¢ Needs Aftention

e My Calendar

e ToDo

e Alerts

Home Page |~

Add Course Module Customize Page | T4

3:00 PM - 4:00 P on 10/19/09:
Guest Lecture

Earth System Science

¥ Mentors Availahle
mare calzndar events..

more snnouncements. ..
To Do =28
My Tasks O | [ =qiit Motification Settings |

My Tasks: What's Past Due Actions ¥

Earth System Science: ¥ All tems (4} ¥

» Slgh up for group praject . ;
What's Due Actions ¥

mare tasks.. Select Date: [10/m7i12000 Go |
What's New (U=l % Today (1) ¥

orksheet 3 /% . pue 10M7109

Edit Maotification Settings | Actions ¥ |
¥ Tomorrow (0) ¥
¥ Announcements (1) ¥ ¥ This Week (1) ¥
¥ Assignments (4} ¥ Futura i1} =
Figure 4

The instructor chooses the page layout and modules available from a pool of modules
managed by the system administrator. Other types of content cannot be added to the
Home Page or other Module Pages. For example, you cannot add a tool link on a
Module Page.
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Adding and Removing Modules

A variety of modules can be added to the Home Page. Use the following table to
decide which modules are appropriate for your course.

¥ Add ¥ If you want to

Alerts Receive notifications of past due and early warning items

Calculator Provide a calculator

Dictionary Allow users to search for terms in the American Heritage
Dictionary

My Display current announcements with links to the

Announcements Announcements tool

My Calendar Display current calendar events with links to the Calendar tool

My Tasks Display current tasks with links to the My Tasks tool

Needs Atftention Receive notifications of items needing attention, such as items
to be graded

Report Card Display the student’s grades

Thesaurus Allow users to search for synonyms using Roget’s ll: The New
Thesaurus

To Do Display items due and past due with links to the items

What's New Display items recently added with links to the items

Textpad

Type plain text or HTML for display on the page



Customizing Your Course: Adding and Removing Modules

TIP: The Alerts and Needs Aftention modules contain instructor-oriented information. If
the modules are included, students will see them on the Home Page, but they will
contain no information. To minimize confusion, you can create a separate Module
Page on the Course Menu containing these modules. Since this Module Page is only for
your use, make it unavailable to students.

If a module with content is removed, when the module is added again, the content is
regenerated.

» QUICK STEPS: adding modules

1. In Edit Mode, access the Home Page.
2. Click Add Course Module on the Action Bar.

3. Onthe Add Module page, select the check box for each module you want to
add.

4. Click Submit.

Home Page

52 Add Module

o

|l Select Modules

Select modules to appear on the page: Home Page

@ Alerts

Displays notifications of past due and early warning items for all the courses
relevant to the user.

] Calculator

Displays a calculator tool.
1 Content Collection: Course Content

Content Collection module for a user's Course content.
@ Dictionary

Figure 5.1
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Customizing Your Course: Adding and Removing Modules

While viewing the Home Page in Edit Mode, remove a module by clicking Close,
represented by the X.

3:00 PM - 4:00 PM on 10/19/09;
Guest Lecture

mare calendar events. ..

Figure 5.2
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Reordering Modules

You can change the module order so the most important modules appear near the top
of the Home Page. Use the Keyboard Accessible Reordering tool or the drag-and-drop
function to reorder the modules.

Custo mim
Reorder: Modules e
olumn 2

My Calendar o
To Do 3:00 PM - 4:00 PM on 10/15/09:

Meeads Attentian Mid-term Exam
Mid-term exam &:30 Ak - 10:00 AW Tyler Hall Room 303

Caolurmn 1
My Announcements
My Tasks

What's Mew

Alerts

~Br R 3:00 PM - 4:00 PM on 10/19/09:
Guest Lecture
Cancel Submit

more calendar events...

Figure 6

» Take Note

A. The Keyboard Accessible Reordering tool is accessed on the Action Bar.

B. In addition to the up and down move arrows, the Keyboard Accessible
Reordering tool also has arrows to move modules right or left between the two
columns on the Home Page.

C. Point to the top of a module to access the move icon, which consists of four
arrows. Press and move the module to a new position on the page.
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Editing Notification Seftings

You can select which items will appear in the following notification modules: What's
New, To Do, Alerts, and Needs Attention. Customizing these notifications will not affect
the students’ nofification settings.

Depending on administrator settings, the following items may be included:

e Announcement Available

e Assignment Available, Due, Past Due, or Submitted
e Content Item Available

e Early Warning System Rule Details

e |tem Due or Graded

e Survey Available, Due, Overdue, or Submitted

e Test Available, Due, Overdue, or Submitted

e Unread Blog Posts

e Unread Discussion Board Messages

e Unread Journal Entries



Customizing Your Course: Editing Notification Setftings

» QUICK STEPS: editing notification settings

1. In Edit Mode, access the Home Page.
In one of the notification modules, click Edit Notification Settings.

On the Edit Notification Settings page, select the link to the course.

> 0N

On the Current Notification Setting page, in the Dashboard column, select the
check boxes of the items to appear or clear the check box of an item not
needed.

5. In the Email column, select the check boxes for the items to which you want to
receive an email notification; clear the check boxes if an email notification is no
longer needed.

6. Click Submit.

What's New

Actions

Edit Motification Settings |

£«

¥ Announcements (1)

<«

¥ Assignments (3)

¥ Content {3)

<«

¥ Courses/Organizations (1)

<

Lo

¥ Discussion Board (1)

Edit Notification Settings Current Notification Setting: Earth System Science

& indicates settings have been changed fram defa Cancel

Notification Destinations
» Edit General Settings

cchug@rmyschool.edu

Define general notification setlings such as
deletion schedule, and reminder schedule f 2.

Settings

arganizations.
Notification Dashhoard ] Email
» Edit Individual Course Settings ARFOURCErRERt Availahle 0
Wieww the current notification settings for cou ) .
are enrolled. Make changes to the notificatio Assignment Available O
specific coursa, Assignment Due 0
Astranormy 101
Earth Systern Science Assighment Past Due F]
Assignment Submitted o
Content ltern Available ol

Figure 7 - The system administrator determines if the Email option is available.
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Hands-on Activity @

For this activity, use your Practice Course.

Create your Home Page and make the following customizations:

Create Home Page and Add Modules
e Create a Module Page on the Course Menu. Name it Home Page.
e Access your new Home Page and add several course modules.
Organize Modules
e Remove one of the modules.
e Reorder the modules.
Edit Notification Settings

e Clear the check boxes for selected noftifications.

e Inthe page header, use the Courses tab and select the course name to return
to the course.



5.0 Day 1 Tasks

In this section, you will complete some common activities to prepare your online course
for students. First, you will create a welcome announcement and add calendar entries
for upcoming events. Then, you will finish the Getting Started Content Area created
earlier by adding syllabus lessons, creating a discussion forum where students can pose
questions, and adding textbook information.

Learning Objectives

After completing this section, you will be able to:

e Create an announcement
e Add calendar entries

e Add syllabus lessons

e Create a discussion forum

e Add textbook information



Creating Announcements

Use the Announcements tool to provide students with course reminders and updates.
Announcements can contain text, images, and multimedia, as well as links to course
content. If the Home Page includes the What's New and To Do modules, students will
already be alerted to new content, assignments, and discussion posts. Therefore,
consider creating announcements only for items that will not appear in the modules.

Announcements appear in the order posted with the most recent announcement
appearing first. You can create permanent announcements, which will appear at the
top of the list, before all dated announcements.

NOTE: When performing the instructor functions, ensure Edit Mode is ON.

» QUICK STEPS: creating an announcement

1. On the Control Panel, under Course Tools, select Announcements.
2. Onthe Announcements page, click Create Announcement on the Action Bar.

3. On the Create Announcement page, type the Subject and an optional
Message. Format the Message text using the Text Editor functions, if you want.

4. Under Web Announcement Options, select Permanent or Date Restricted.

5. If applicable, select the Display After and Display Until check boxes and type the
dates and times.

6. Optionally, under Course Link, click Browse to create a link from the
announcement to a course item. Select the course item from the pop-up Course
Map.

7. Click Submit.

: » | Announcements

“ Files iw
# Course Tools

Blogs

Collabaration

Contacts

Course Calendar

Dizcuzzion Board

Gloszary

Journals
Figure 1.1
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Day 1 Tasks: Creating Announcements

@ Create Announcement

He Indicates a required field. Cancel

1. Announcement Information

# Subject e \Presentation Plans | [} ¥/ Black

Message

“izual Editor: m:l
|

*|Nu:urma| V||3 V||TimesNewRDman VH B I U ahe| % x H
cds ¥ N & o PO AL | IO O
“BEO RS B M

Tour Prezsentation Plans assignment 12 due two weeks from today and 15 worth 50 pomts. Find
mote imstructions i the nk to the Assignments Content Area

HRE
mmm

Ak

Ay
[0

*| Path: body
[] save as Reusable Ohject

A Web Announcement Options

Duration {7y Permanent
(& Date Restricted

Select Date [] Display After[07/29/2008 | [E|[06:39 PM =]
Restrictions [] Display Until|07/20i2008 | [ [06:39 PM =]
Ovarride User ]
M otification Settings

=M Course Link 6
Click Browse to choose an item.
Lut:atiﬂll|IA55ignmentsIF'resentE| Browse. . |

Figure 1.2

The Subject becomes the fitle of the announcement on the Announcements page. In
the Message text box, you can add text, images, multimedia, and links using the Text
Editor functions.

Select the Override User Notification Settings check box if you want to send students an
email containing the announcement. The email will be sent to all students, even those
that chose not to receive announcement notifications through email.
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Adding Calendar Entries

Use the Course Calendar to provide students with dates for important events. Course
Calendar Events appear to all members of the course. Common entries include
upcoming tests, due dates for assignments, or special lectures. Due date nofifications
also show in the What's New and To Do modules. However, due date notifications can
be turned off by students, so be sure to let them know if you are relying on those
modules to remind them of due dates.

» QUICK STEPS: adding a calendar entry

1. On the Control Panel, under Course Tools, select Course Calendar.

2. On the Course Calendar page, select a Calendar view: Day, Week, Month, or
Year.

3. Click Create Course Event on the Action Bar.

4. On the Create Course Event page, type the Event Name and Event Description.
Format the Event Description text using the Text Editor functions, if you want.

5. Type the Event Date. Optionally, click the pop-up Date Selection Calendar to

select the date.

6. Type the Event Start Time and Event End Time. Optionally, click the pop-up Time
Selection Menu to select the times.

7. Click Submit.

# Control Panel

¥ Files

3

# Course Tools

Announcements
Blogs
Collzkhoration
Contacts

Course Calendar
Dizcussion Board
Glozzary
Journals

Send Email

Tazks

o>

Testz, Surveys, and Pools

View Day = View Week

Y
[

Course Calendar: View By Day

O

View Month

View Year

Jump to

Figure 2.1
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Day 1 Tasks: Adding Calendar Entries

Create Course Event o

% Indicates a required field. Cancel m
8 Event Information

7 Event Name |Research Paper Topic Discussion in Chat|

Ewvent Description
‘lhlnrmal jﬁ es Mew Roman j| B 7 U abk=s ¥ = =
~calc ¥ I & v o O FA S o O
“BEEORE B M

If you would like help selecting your Research Paper topic, or need help
narrowing down the topic, please attend the special Chat session.

R

4 Path: body

O Save as Reusable Object

72 Event Time 5
Event Date [10/26/2008 | 6

Event Time Event Start Time [10:00 AM | & x

Event End Time [11:00 AM | &) | 12:30 AM |

(e
01:30 AM
02:00 AM
02:30 AM
03:00 AM
03:30 AM
04:00 AM

0430 AM
: <5

c

[«

Figure 2.2

The Event Name will appear as the link on the Course Calendar. Click the link to display
the Event Description. There is a 4,000 character limit for Event Descriptions.
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Hands-on Activity @

For this activity, use your Practice Course.

Announcements

¢ Create an announcement welcoming your students to your online course.

Calendar

e Create one or two calendar entries for upcoming events.

e Turn Edit Mode to OFF. On the Course Menu, click Tools and view a calendar
entry as your students will see it. Select different calendar views.
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Building Your Syllabus

Earlier you added a syllabus to the Getfing Started Content Area. Now, you will return
to the syllabus to add information about each week’s lessons.

> QUICK STEPS: building the syllabus

1. On the Course Menu, click Getting Started.

Click the syllabus’s Action Link to access the contextual menu.
Select Edit.

Click Add Lesson on the Action Bar.

On the Edit Lesson page, type the Lesson Title.

If applicable, select a specific Lesson Date and Time.

N oo~ LD

In the Lesson Description text box, type information. Format text using the Text
Editor functions, if you want.

Click Submit.

©

9. To add more lessons, repeat steps 4-8.

10. Click OK.

Getting Started

Build Content % Add Interactive Tool % Disc

1 Introduction to Oceanography Syllabus’Q

Introduction to Oceanography, . Edit
DESCRIPTION

This course will deal with histarical and modern  © Adaptive Release

research of both early and madern ocean exploral » Adaptive Release: Advanced
wee will investigate how technological advances h ) :
fquestto learn more about odr oceans, The cours » Set Review Status(Disabled)
issUes related to oceanodraphy by presenting thg Wetadata
assignments.

» Tracking (Enahled/Disabled)

Duting the semester there will be several guestld » User Progress
online aswell as several individual and group prg
formulate your final evaluation for this course. » Copy

LEARHING OBJECTIVES » Deleta

Figure 3.1



Day 1 Tasks: Building Your Syllabus

Add Lesson o

Introduction to Oceanography Syllabus
DESCRIPTION

Figure 3.2 - Click Add Lesson on the Action Bar

& Lasson Title |Lessnn 1: Qrigin and Morpholooy of Ocea

Color of Marne B | Black

Lesson Date and Time Mo Lesson Date

L 1=

Mo Lesson Times

Start Tirme [06:50 PM (=]
End Time [07:50 PM [=]

“|Mormal v | |3 Arial v||]§|1’ U abe | = x2||§§§|§z =
¥ On i@ o @OJAZ VIO O

Lesson Description
B Yisual Editor: m:l

Tt
(]
Ik
(]

Edit Lesson: Introduction to Oceanography Syllabus 0

% Indicates a required field. Cancel m

» Describe variations in deep ocean relief using proper terminology
m Recognize processes responsible for creating ocean basin features

Figure 3.3 - The Edit Lesson page
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Creating a Discussion Forum

Earlier you added a link to the Discussion Board from the Getting Started Content Area.
Now, you will create a discussion forum.

» QUICK STEPS: creating a discussion forum

1. On the Course Menu, click Getting Started.
2. Click the Discussion Board link in the Content Area.

3. On the Discussion Board page, click Create Forum on the Action Bar.

4. Type a Name. Users will click the forum name to access the forum.

5. Optionally, type instructions or a description in the Description text box. Format
the text using the Text Editor functions, if you want. The Description will appear
below the forum name.

6. Under Forum Availability, select the Yes option.
7. Select Forum Settings.
8. Click Submit.

[/ Getting Started

I @ Discussionanrdo

Discussion Board

E

€

Figure 4.1

NOTE: The Discussion Board can also be accessed from Course Tools on the Control
Panel or from a Discussion Board link you add to the Course Menu. The process for
creating forums is the same regardless of how the Discussion Board is accessed.
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Day 1 Tasks: Creating a Discussion Forum

Create Forum

e Indicates a required field.

M8 Forum Information
% MName llcehreaker Farurm 4 |
Description
“[mormal v | [3 %] [arial vl |B I U == % £ |[=

~E X NG & v oo @
‘B EO RS BB

Let's start out by getting to know each other. Please use your name 3
post. Include some information about yourself, such as why you chos
ife, favorite movie, and anything else you see fit to share.

A7 | Jx& o O

*| Path: body
[] Save a= Reusable Ohject

B8 Forum Availability

Lyailable 6 @ Yes () No

Enter Date and TiMe  [] Display After| WEN |

Restrictions

®
[] Display Until| | E| |(=]

=Ml Forum Settings

[] Allow Anonymous Posts

[] Allow Author to Delete Own Posts o
All posts

Qnly posts with no replies

Figure 4.2

TIP: All forums needed for the term can be created in advance and the Forum
Availability can be set to No until they are needed.
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Adding Textbook Information

You can create items in a Content Area for each textbook used in your course. The
Search for Textbook tool enables you to search an external source for textbooks by
ISBN, title, author, or subject. You can also add textbook information manually.

When textbook information is added to a course, it is also added to the Course Catalog
where perspective students can access this information prior to enrollment.

NOTE: The system administrator determines if the Search for Textbook tool is available. If
available, you can turn this tool on and off from the Control Panel > Customization >
Tool Availability. When this tool is disabled, you will not see Assign Textbook on the
Action Bar in a Content Area.

» QUICK STEPS: adding textbook information

1. Access the Content Area where the textbook information will appear.

2. Point to Assign Textbook on the Action Bar to access the drop-down list.
3. Click Search for Textbook.
4

On the Search for Textbook page, use the drop-down lists and type Keywords to
search for a textbook.

5. Click Go.
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Day 1 Tasks: Adding Textbook Information

|/ Getting Started
Add Interactive T 2) ] Amign Textbook ¥

» Search for Texthook
» Manual Entry Texthaoo

Search for Texthook

Search Fenywards Type Currency

FiSBn W |[Earth Seiences & %] FUS Doliars USDS P co
ISBM All

Digital Argentinean Peso ARSS

Author Australian Dollars AUDS

Suhject Brazilian Feal BELRES

British Pound GBFE

Canadian Dollars CHNDS

Colombian Peso COPS

Danish Krone Dkkkr

Euro EURE

Haong Kong Dollar HKD S

Indian Rupee INRRp

Japanese Yen JPE

Mexican Mew Pego MHPS

Mew Fealand Dollars MZDE
Morwegian kKroner MOkkr

Russian Ruble RURpYE

Saudi Arabian Rival SAR . n
South African Rand ZARR

South Korean Won KR

Swedish Krona SEKkr w

Figure 5.1 — Use the drop-down lists and type Keywords to search for textbooks

After clicking Go, your search results appear.



Day 1 Tasks: Adding Textbook Information

Search for Textbook

Search keyvwords Type CUrrency
| Title  + | [Earth Seiences || Print | |US Dollars USD$ v| | co

Sort By | 1SBM | G0 o e

“ < Page| 1 |of2 | #

Displaying 1 to 25 of 46 items

o Foundations of Earth Science (Application in Earth Science)
O limage

available Authaor Lutgens

[SEM: 47 8-0-536-40426-8
Select

Fublizher: Pearson Higher Education&Professional Group
> Take Note

Figure 5.2

A. You can sort your results using the Sort By drop-down list, which includes sorting
by ISBN, Title, Author, Publisher, or Price.

B. The number of items found appear.
Navigate to other results pages using the arrows.

D. Click Select next to the appropriate textbook information. You will be taken to
the Create Textbook page before the item is added.



Day 1 Tasks: Adding Textbook Information

Create Textbook

% Indicates a required field.

Back Submit and Add Another Submit

1. Textbook Information

Title Earth Science
TEXTBOOK Suhtitle Earth Science PE
ISER 878-0-618-30368-7
IMAGE FPublisher MecDougal Littell Incorporated
NOT AVAILABLE Fublished Date January 1, 2005
Binding Trade Cloth
Frice Fro.08
Type Print

e Texthookin Course o] Required (3] Recommended

Description Earth Science offers a user-friendly overview of our
physical enviromnent with balanced, up-to-date cover
of geology, oceanography, astronomy, ahnd meteorology
the undergraduate student with little background in

S
2.
Permit Users to View (& Yes (O Mo
this Content
Track Murmber of 3 Yes (&) Mo
B
Select Date and Time ] Display After | ||| | @
Restrictions [] Display Until| | &|| =]
Figure 5.3
» Take Note

A. On the Create Textbook page, select whether a textbook is required or
recommended.

B. Type an opftional Description, which will appear below the textbook fitle in the
Content Area. Descriptions have a 255 character limit.

C. Under Options, select Yes to Permit Users to View this Content.

D. Click Submit to add the textbook information to the Content Area or Submit and
Add Another fo add more textbooks.

NOTE: The pre-filled information on the Create Textbook page is not editable because it
comes from external data. You can edit the Description at any time.
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Day 1 Tasks: Adding Textbook Information

If a search does not provide your textbook, you can type information in the provided
fields on the Manual Entry Textbook page. This information is editable at any time. Any
text boxes without information will not appear in the Content Area; however, the Title is
required.

Optionally, include an image of the book by clicking Browse My Computer or Browse
Course Files to locate the file. If an image is not uploaded, a default is used.

7 Getting Started -

Build Content 3% Add Interactive Tool 3%

Assign Textbook 3%

» Seatch for Textbook
» Manual Entry Texthook

Manual Entry Texthook

% Indicates a required field. Cancel || Submit and Add Another m
)
ISBN | |
o Title | |
Subtitle | |
Authar [ |
Fublisher [ |

Published Date L

Binding [
Description
&
Currency | USs Dollars USD§ e

7 Textbook in Course (&) Required (O Recommended

Pl Textbook Image

Aftach File Browse My Computer | Browse Course Files

M Options

Permit Users to View (&) Yes (O Mo
thiz Content

Track Mumber of () Yes (& Mo

Wiews

Select Date and Time [ Display After | E (=]

Restrictions [ Display Until | E|| | &)
Figure 5.4
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Best Practice: Welcome Your Students

Your students' first impressions will influence their opinions and attitudes about your
course.

Let students know you are glad they are here. An inviting fone—somewhat
informal, but still professional—is equivalent to a smile and a greeting tfo a
student who walks through the door in a traditional class.

Think about how your students might feel when they enter your course for the first
time. To put students at ease, include the following:

A welcoming message and brief self-infroduction
Specific instructions on how to begin the course

lcebreakers to build a sense of camaraderie and community



Hands-on Activity E

For this activity, use your Practice Course.

Syllabus

e Access the syllabus in the Getting Started Content Area. Add at least one lesson
to your syllabus.

Discussion Board

e Create a Getting Started discussion forum.

e Turn Edit Mode to OFF. From the Course Menu, preview the Getting Started
Content Area and access the Discussion Board forum.

Textbook Information

e From the Getting Started Content Areq, if Assign Textbook appears on the Action
Bar, search for a textbook and add it to your course. Select whether the
textbook is Required or Recommended. Type a Description and make the
textbook information available to your students.
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7.0 Workshop Wrap Up

The Workshop Wrap Up provides the opportunity to reflect on what has been learned
by focusing your attention on the key concepts presented in the workshop. Also, the
next page includes a worksheet for brainstorming some ideas about how to get started
in your online course.

In this workshop, you learned how to do the following:

Log in to Blackboard Learn and explain the information available on the My
Institution tab

Add, remove, and reorder modules on the Home Page
Add and access content and tools from the Course Menu and Tools link

Explain the steps for planning, creating, customizing, and editing the Course
Menu

Describe strategies for planning Content Areas and organizing the content
Create Content Areas and add course materials and tools
Edit and reorder items in a Content Area

Explain the main functions of the Control Panel used to customize the course
style

Select the default Course Menu view: List View or Folder View

Select the course enfry point and add a banner to it

Change tool availability

Edit the nofification settings

Create announcements, calendar entries, syllabus lessons, and discussion forums

Add textbook information to your course



Spotlight on YOUR Course

Do you have some ideas about getting started? Use the following worksheet to record
your plans.

¥ Ideas to consider ¥ Notes

How will you organize your Content Areas?

¢ Will you organize by subject, chronology, or type of contente

e Willyou link to tools from Content Areas or have students access
tools from the Course Menu or Tools link?

e Will you add an existing Syllabus or use the Syllabus Builder option?

Will you customize your course?

e Willyou change the Course Menu style or colors?

e Will you change the course entry pointe

What Day 1 tasks are important for your course?2

e Will you create a welcome announcement for studentse
¢ What initial events do you want to add to the Course Calendar?

e Will you create a discussion forum to allow students to pose
questions or issues related to the course and online learning?

e Will you search for textbook information to add to your course?




